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Abstract 

 

This paper deals with developing a lesson plan to show how the teaching of basic statistical 

methods via Excel and Statdisk software can help the students to gain the knowledge and 

insights from various aspects of sustainability data, such as studying and conducting some 

statistical analysis of the carbon monoxide data, among others. Such studies are important in 

view of the facts that there is a great emphasis on statistical literacy and critical thinking in 

education these days. An introductory course in statistics such as Statistical Methods (STA 

2023) at Miami Dade College can easily provide such avenues to our students. In any Statistical 

Methods (STA 2023) Class, the students are first taught the frequency distributions, statistical 

graphs, and basic descriptive statistics, that is, center, variation, distribution, and outliers, which 

are important tools and techniques for describing, exploring, summarizing, and comparing data 

sets. Due to the tremendous development of computers and other technological resources, the use 

of statistical software for data analysis, in a Statistical Methods (STA 2023) course, cannot be 

underemphasized and ignored. Therefore, this paper shows how to use sustainability data to 

teach Statistical Methods (STA2023) course via Excel and Statdisk software. It is hoped that by 

implementing the techniques discussed in this paper in preparing lesson plans will help us to 

develop in our students the quantitative analytic skills to evaluate and process numerical data, 

which is one of the Gen Ed Outcomes of Miami Dade College. 
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1. Introduction: Sustainability of our environment is an issue of emerging international 

importance and significance. As observed by Newman and Kenworthy (1999), “Sustainability is 

a state of dynamic equilibrium achieved by taking responsibility for balancing long-term 

economic environmental and social health. The concept of sustainability has emerged from a 

global political process that has tried to bring together, simultaneously, the most powerful needs 

of our time: (1) the need for economic development to overcome poverty; (2) the need for 

environmental protection of air, water, soil, and biodiversity, upon which we all ultimately 

depend; and (3) the need for social justice and cultural diversity to enable local communities to 

express their values in solving these issues”. Since mid-1980s, considerable research into various 

aspects of issues related to environmental sustainability has been conducted. For example, the 

concentration of „greenhouse‟ gases (namely, carbon dioxide, methane, nitrous oxide, ozone, and 

chlorofluorocarbon) in the Earth‟s atmosphere, resulting in a gradual increase in temperatures at 

the Earth‟s surface, is an important issue and area of research. There is a rising trend of average 

global temperatures over recent years. Ecologists around the world are concerned about global 

warming. There are many causes and effects of such a global warming. One possible effect is the 

melting of the icecaps. According to the research, the scientists believe that the “greenhouse 

effect” may also be one of the causes of global warming. Smog and pollution in the atmosphere 

create a cover over the surface of the Earth. The heat of the sun hits the surface of the Earth and 

bounces off, but tends not to leave the surface because of the cover of pollution. Since 1959, the 

carbon dioxide content of the atmosphere has increased 13 %. The primary sources of this 

increase are the exhaust of automobiles, deforestation and other human activities. Emissions of 

greenhouse gases worldwide resulting from the exhaust of automobiles, deforestation and human 

activities are expected to contribute to future climate changes. There is a number of potential 

impacts on the sustainability of ecosystems including warmer temperatures and rising sea levels, 

changes in rainfall patterns, and increased storm and cyclone intensity due to climate change. 

Consequently, these impacts are presenting many challenges for our world‟s environment, 

community and economy.  

 

Statistics is one of the important sciences at present. In order to summarize any type of data, we 

cannot underestimate its role, use and importance in the modern world. There is a great emphasis 

on statistical literacy and critical thinking in education these days. An introductory course in 

statistics such as Statistical Methods (STA 2023) at Miami Dade College can easily provide such 

avenues to our students. In any Statistical Methods (STA 2023) Class, the students are first 

taught the frequency distributions, statistical graphs, and basic descriptive statistics, that is, 

center, variation, distribution, and outliers, which are important tools and techniques for 

describing, exploring, summarizing, and comparing data sets. Due to the tremendous 

development of computers and other technological resources, the use of Statistical Software for 

data analysis, in a Statistical Methods (STA 2023) class, cannot be underemphasized 

and ignored. According to Professor Mario F. Triola, the author of "Elementary Statistics" 
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textbooks, “Statistical Software is now a common technology choice used in 

introductory statistics courses. An important reason many educators choose Statistical Software 

is its extensive use in corporate America. The world of business and industry has embraced the 

spreadsheet as an efficient and effective tool for the analysis of data, and many Statistical 

Software such as SPSS, SAS, Excel, Minitab, Statdisk, among others, have become the premier 

spreadsheet programs. Motivated by a desire to better serve their students by better preparing 

them for professional careers, many instructors now include a Statistical Software as the 

technology tool throughout the statistics course. This marriage of statistics concepts and 

spreadsheet applications is giving birth to a generation of students who can enter professional 

careers armed with knowledge and skills that were once desired, but are now demanded” 

(http://www.statdisk.org/). This paper develops a lesson plan how to use sustainability data to 

teach Statistical Methods (STA2023) via Excel and Statdisk software. For details on Statdisk, 

see, for example, Triola (2010), and http://www.statdisk.org/, among others. For Excel 

demonstration with examples, the interested readers referred to Bluman (2013), and Triola 

(2014), among others. As greenhouse and climate change are fundamental issues of 

environmental sustainability, this project aims at studying and conducting some statistical 

analysis of the carbon monoxide data from 1974 to 1996, at the two monitoring cities of Houston 

and San Antonio, Texas. The organization of this paper is as follows. In Section 2, the use of 

Excel in teaching Statistical Methods (STA 2023) course is presented. Section 3 contains the use 

of Statdisk in teaching courses in Statistical Methods (STA 2023). 

 

2. Uses of Excel: This is an Excel project. It is expected that the students have already learned 

about the following topics in the class: 

 Measures of central tendency (namely, mean, median, and mode) are used to indicate the 

“typical” value in a distribution. A comparison between the median and mean are used to 

determine the shape of distribution, while the mode measures the most frequently 

occurred data. 

 Measures of dispersion or variation (namely, range, standard deviation, and variance) are 

used to determine the “spread out” of the data. 

 Some statistical graphs, for example, histograms, can also be used to describe the shape 

of distribution 

 The five-number summary, namely, the minimum value, the 1st quartile, the median (i.e., 

the 2nd quartile or the 50th percentile), the 3rd quartile (i.e., the 75th percentile), and the 

maximum value are used to construct the box-plot. 

In what follows, we will discuss some special features of Excel and its use for constructing 

frequency distributions, histograms, and descriptive statistics. 
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2.1. Some Special Features of Excel: These are described below.   

 

Statistical Analysis Tools: Microsoft Excel provides a set of data analysis tools-called the 

Analysis ToolPak-that you can use to save steps when you develop complex statistical or 

engineering analyses. You provide the data and parameters for each analysis; the tool uses the 

appropriate statistical or engineering macro functions and then displays the results in an output 

table. Some tools generate charts in addition to output tables. 

Related Worksheet Functions: Excel provides many other statistical, financial, and engineering 

worksheet functions. Some of the statistical functions are built-in and others become available 

when you install the Analysis ToolPak. 

Accessing the Data Analysis Tools:  The Analysis ToolPak includes the tools described below. 

To access these tools, click Data Analysis on the Tools menu. If the Data Analysis command is 

not available, you need to load the Analysis ToolPak add-in program. 

Descriptive Statistics Analysis Tools: The Descriptive Statistics Analysis tool generates a 

report of univariate statistics for data in the input range, providing information about the central 

tendency and variability of your data. 

Histogram Analysis Tools: The Histogram analysis tool calculates individual and cumulative 

frequencies for a cell range of data and data bins. This tool generates data for the number of 

occurrences of a value in a data set.  

2.2. How to Perform a Statistical Analysis: These are described below.    

 On the Tools menu, click Data Analysis. If Data Analysis is not available, load the 

Analysis ToolPak as follows:  

 On the Tools menu, click Add-Ins.  

 In the Add-Ins available list, select the Analysis ToolPak box, and then click OK.  

 If necessary, follow the instructions in the setup program.  

 In the Data Analysis dialog box, click the name of the analysis tool you want to use, then 

click OK.  

 In the dialog box for the tool you selected, set the analysis options you want. 

2.3. Applications of Excel in the Statistical Analysis of a Sustainability Data: Sustainability 

of our environment is an important issue of international significance. Since mid-1980s, 

considerable research into various aspects of issues related to environmental sustainability has 

been conducted. For example, the concentration of „greenhouse‟ gases (namely, carbon dioxide, 
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carbon monoxide, methane, nitrous oxide, ozone, and chlorofluorocarbon) in the Earth‟s 

atmosphere, resulting in a gradual increase in temperatures at the Earth‟s surface, is an important 

area of research. Emissions of greenhouse gases worldwide resulting from human activities are 

expected to contribute to future climate changes. There is a number of potential impacts on the 

sustainability of ecosystems including warmer temperatures and rising sea levels, changes in 

rainfall patterns, and increased storm and cyclone intensity due to climate change. Consequently, 

these impacts are presenting many challenges for our world‟s environment, community and 

economy. Many researchers have examined and analyzed different air pollutant concentrations, 

both statistically and experimentally. A majority of statistical studies, whether experimental or 

observational, are comparative in nature. The simplest type of a comparative study compares two 

populations based on samples drawn from them. As greenhouse and climate change are 

fundamental issues of environmental sustainability, this project aims at studying and conducting 

some statistical analysis of the carbon monoxide data from 1974 to 1996, at the two monitoring 

cities of Houston and San Antonio, Texas. To access to these data, the interested readers are 

referred to the following sources: 

Sources:  

Texas Environmental Center Websites: 

• http://www.tec.org/ 

• http://www.texascenter.org/almanac/Air/AIRCH6P3.HTML  

NASA Goddard Institute for Space Studies Website: 

• http://data.giss.nasa.gov/, 

http://eosweb.larc.nasa.gov/PRODOCS/narsto/table_narsto.html  

University of California Scripps Institution of Oceanography Website: 

http://cdiac.esd.ornl.gov/trends/trends.htm 

Microsoft Excel is an efficient and effective tool for analyzing such data. As such, we shall 

use Excel for constructing frequency distributions, generating histograms, and finding basic 

descriptive statistics for the analysis of said carbon monoxide data, which are presented in 

the following paragraphs. 

(a) Excel for Accessing the Data Analysis Tools: See Figure 1 below. 
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Figure 1 

(b) Excel for Constructing Frequency Table or Frequency Distribution: See Figure 2 

below. 
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Figure 2 

(c) Excel for Generating Histogram: See Figure 3 below. 

 

Figure 3 

(d) Excel for Descriptive Statistics: See Figure 4 below. 
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Figure 4 

(e) Excel Output of Statistical Analysis of Carbon Monoxide Data, Houston and San 

Antonio, Texas, 1974 – 1996: See Figure 5 below. 

FREQUENCY DISTRIBUTIONS 
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Figure 5 

(f) HISTOGRAMS: See Figure 6 below. 

 

Figure 6 

(g) DESCRIPTIVE STATISTICS: See Figure 7 below. 

 



10 

 

Figure 7 

3. Uses of Statdisk: This is a Statdisk project. Statdisk is a full featured statistical analysis 

package. It includes over 70 functions and tests, dozens of built-in datasets, and graphing. 

Statdisk is free to users of any of Pearson Education Triola Statistics Series textbooks.  

 

3.1. Some Special Features of Statdisk: These are described below.    

 

Help Overview, Sample Editor / Data Window  

 Many individual modules include their own Help comments. Here we provide some 

comments about the Statdisk main menu bar at the top. 

 File: Click on File to open an existing file or to save a file that has been created in the 

Statdisk Data Window. The "Open" and "Save As" features require that you select the 

location of the file to open or saved. If the default that is displayed is not what you want, 

click on the small box to the right of the default location and proceed to select the desired 

location. 

 Edit: Click on Edit to Copy a Statdisk file to another application or to Paste a file from 

another application. 

 Analysis: Click on Analysis to access many of the Statdisk modules, including those 

related to such features as confidence intervals and hypothesis testing. 

 Data: Click on Data to access Statdisk features such as those related to descriptive 

statistics, histograms, and boxplots. 

 Data Sets: Click on Datasets to access the list of data sets in Appendix B of the textbook. 

 Window:  The Window menu lists all of the windows currently open in your Statdisk 

session.  You can click a window (or use its hotkey combination) to bring it to the front. 

 Help:  The help menu will open help from this site for the various Statdisk windows. 

 There are also links to additional resources such as the Statdisk Workbook and the Triola 

Statistics website. 

 The Statdisk Sample Editor serves as a basic starting point for using Statdisk. Many of 

the modules in Statdisk  require raw data in order to perform a statistical analysis. The 

Statdisk Data Window allows you to manually enter lists of raw data.  

3.2. Applications of Statdisk: In the following examples, the uses of Statdisk are demonstrated.  
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(a) Descriptive Statistics: See Figure 8 below. 

 

 

 

 

 

 



12 

 

Figure 8: THE ATMOSPHERIC CARBON MONO OXIDE CONCENTRATIONS IN PARTS 

PER MILLION (PPM) DATA AT MAUNA LOA AND CAPE KUMUKAHI, HAWII 

(http://cdiac.esd.ornl.gov/trends/trends.htm, 13 June 2002) 

(b) Histogram and Frequency Distribution: See Figure 9 below. 

 
 

 

 

 

 

 

Figure 9: THE ATMOSPHERIC CARBON MONO OXIDE CONCENTRATIONS IN PARTS 

PER MILLION (PPM) DATA AT MAUNA LOA AND CAPE KUMUKAHI, HAWII 

(http://cdiac.esd.ornl.gov/trends/trends.htm, 13 June 2002) 
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(c) Boxplots: See Figure 10 below. 

 

 Figure 10: THE ATMOSPHERIC CARBON MONO OXIDE CONCENTRATIONS IN PARTS 

PER MILLION (PPM) DATA AT MAUNA LOA AND CAPE KUMUKAHI, HAWII 

(http://cdiac.esd.ornl.gov/trends/trends.htm, 13 June 2002) 

(d) Normal Quantile Plots: See Figure 11 below. 
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 Figure 11: THE ATMOSPHERIC CARBON MONO OXIDE CONCENTRATIONS IN 

PARTS PER MILLION (PPM) DATA AT MAUNA LOA AND CAPE KUMUKAHI, HAWII 

(http://cdiac.esd.ornl.gov/trends/trends.htm, 13 June 2002) 

(e) Confidence Interval Estimates and Hypothesis Test Mean – Two Independent Samples: 

See Figure 12 below. 

 

 

 

 

 

 

 

 

 

Figure 12: THE ATMOSPHERIC CARBON MONO OXIDE CONCENTRATIONS IN PARTS 

PER MILLION (PPM) DATA AT MAUNA LOA AND CAPE KUMUKAHI, HAWII 

(http://cdiac.esd.ornl.gov/trends/trends.htm, 13 June 2002) 

4. Concluding Remarks: In this paper, we have discussed about developing a lesson plan to 

show how the teaching of basic statistical methods via Excel and Statdisk software can help the 

students to gain the knowledge and insights from various aspects of sustainability data, such as 

studying and conducting some statistical analysis of the carbon monoxide data, among others. It 

is hoped that this paper will be helpful in teaching any introductory course in statistics such as 

courses in Statistical Methods (STA 2023) at Miami Dade College using Excel and Statdisk. 

Further, as there is a great emphasis on statistical literacy and critical thinking in education these 

days, it is hoped that, with the help of Excel and Statdisk, the students will be able to conduct 

statistical research projects in their STA2023 courses, and will be able to achieve the following:  

I. Search or web-search any real world data. 

II. Analyze the data statistically using Statdisk, that is, 

           Compute descriptive statistics for any real world data;  

           Draw histograms and other statistical graphs for data sets;  
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           Discuss the distributions of data sets;  

           Other Statistical Analysis.  

III.   Write a statistical research project or report by incorporating the above findings.  

IV.   Present the research project.   

Finally, it is hoped that by implementing the techniques discussed in this paper in preparing 

lesson plans will help us to develop in our students the quantitative analytic skills to evaluate and 

process numerical data, which is one of the Gen Ed Outcomes of Miami Dade College. 
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